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1
Overview
1.1

System Overview

In neuroscience, the fiber photometry denotes a method whereby chronically implanted optical fiber delivers excitation
light to neurons tagged with a fluorescent calcium indicator(s) and collects their overall activity-induced fluorescence.
Within the field of view, the fiber photometry sums up the activity-induced fluorescence of all neurons expressing the
indicator(s).
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Figure 1.1: Typical Modular Fiber Photometry Measurement Setup
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The typical set-up for freely behaving animals consists of the fiber photometry console, the excitation light source(s),
a connectorized fluorescence mini cube with beam splitters that combine the excitation wavelengths and separate the
fluorescence light, the fiber-optic rotary joint, the optical cannula with connecting fiber-optic patch cords and photodectors capable of sensing the low level light. In vitro or head-fixed animal photometry setup uses a probe holder and an
optical probe instead of the rotary joint and the optical cannula. The fluorescence emission can be collected with one
photodiode and subsequently demodulated or, after spectral separation, collected with respective photodiodes.

1.2

Fiber Photometry Console

This FPGA based data acquisition unit synchronizes the output control and the acquisition of the input data. This device
seamlessly integrates with Doric Neuroscience Studio software, which provides the user-interface for multi-channel
photometry experiments.
The software interface enables control over the CW excitation light pulses, square or sinusoidal waveform of an external source (i.e. LED driver) with 4 digital input/outputs and 4 analog voltage outputs. The software interface displays
real-time data of up to 4 detectors input signals and performs data acquisition. The other new functionalities are being
developed and users can upload them as they become available.
The Fiber Photometry Console inputs and outputs are shown in figures 1.2 and 1.3.

Figure 1.2: Front view of the Fiber Photometry Console: Inputs and outputs
• The LCD Screen displays console information.
• The Digital/IO ports sends 0-4.75 V TTL pulses.
• The HDMI port acquires digital signals and digital communication SPI and LVDS via a custom pinout HDMI connector.
• The Analog-out ports send a variable ± 4.75 V analog signal signal.
• The Analog-in ports acquire analog signals up to ±10 V.
• The Power On/Off opens and closes the device.
Chapter 1. Overview
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Figure 1.3: Back view: Maintenance and Power Supply
• The 12V port connects to the 12 VDC Power supply.
• The USB port allows a USB-B connection to a computer.
• The Service port is a USB-B port through which the firmware of the device can be updated.
• The USB-3 charging port is currently disabled.

Chapter 1. Overview
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2
Operations Guide
2.1

Connecting the Fiber Photometry Console

Power supply adapter
12 VDC

USB cable to computer

Fiber photometry console (FPC)

ON

Digital I/O
OFF

FIBER PHOTOMETRY CONSOLE

1

2

3

Analog Out

4

HDMI

1

2

3

Analog In

4

1

2

3

4

OR

BNC connectors
Power supply adapter
12 VDC

BNC cables
Photoreceiver
module (NPM)
Interlock
plug

KEY SWITCH
ON

LED Driver
(LEDD_2)

Battery
operated

OFF

LED
#1

LED
#2

LED Driver

To Connectorized
ﬂuorescence
mini cube

M8 connectors

To light sources

Figure 2.1: Connections to the Fiber Photometry Console
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Follow this quick start procedure to install and connect the system. We recommend the following order to avoid
device and driver detection problems. If you need more information about each device or the software, refer to their
respective user manuals.
1. Install Doric Neuroscience Studio Software. Follow the on-screen instructions to install the Doric Neuroscience
Studio Software on the hard drive of your computer. For more details, refer to the Doric Neuroscience Studio
Software User Manual.
2. Connect the Fiber Photometry Console. The console unit is operated with a 12 VDC power supply adapter. It
is important to disconnect all other elements from the inputs/outputs before turning on the console. When the
console is powered, turn on the switch, then connect the console to the computer via a USB cable. It is important
to power on the console before connecting the USB cable. Failure to do so can lead to an unstable state in
which the console draws power from the USB cable instead of the power adapter. A Windows USB driver will be
automatically installed. Open the software to complete the installation of others devices.
3. Connect outputs. Digital outputs can send TTL pulses (0 - 4.75 V square pulses) while analog outputs can send a
sinusoidal signal. Connect devices to Digital I/O or Analog Out of the Fiber Photometry Console with a BNC cable
(Fig. 2.1).
4. Connect inputs. Digital inputs receive TTL pulses (0 - 5 V square pulses) while analog inputs receive analog signal
(±10 V signals) that can be displayed and saved using the Doric Neuroscience Studio.

Chapter 2. Operations Guide
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3
Doric Neuroscience Studio
3.1

Photometry Console

The Fiber Photometry Console module controls the Fiber Photometry Console, an FPGA based data acquisition unit which
synchronizes the output control and the input data of the acquisition. The photometry-oriented interface provides different functionalities for multi-channel experiments. It enables control over the excitation light pulses, or the sinusoidal
waveform trig of an external source (i.e. Doric LED driver) with 4 Digital input/outputs and 4 Analog outputs, which
allow the creation of pulse sequences. The module interface displays real-time recordings of up to 4 input signals and
performs basic signal processing. The system is controlled using 3 Control and Settings tabs. Separate channel windows are used to define output/input specifications.

Figure 3.1: Console User Interface

8

3.1.1

Channels

The console has three different types of channels. The Digital I/O (Section 3.1.1) channels allow the input and output of
TTL signals. The Analog Output (Section 3.1.1) channels allow the output of analog signals. The Analog Input (Section
3.1.1) channels allow the input of analog signals. Any number of channels may be added using the Add channel button
on the Configuration tab (Section 3.1.2). The Channel(s) configuration window contains the following elements shared
by most channel types.

Figure 3.2: Channel(s) configuration window, Digital I/O input
1. The Channel Types (Fig. 3.2) are selected in the box on the left side of the window. Selecting the Digital I/O ,
Analog-Out or Analog Input icons will display the parameters to each respective Channel type on the right side
of the window.
2. The Channel Options (Fig. 3.2) include the Channel drop-down list and the channel Mode list.
a) The Channel identifies which of the 4 channels available for each channel type is currently being modified.
The channel can be changed by selecting a new one from the drop-down list.
b) The Mode identifies the type of signal sent (for output channels) or the way the signal is measured (for input
channels). The specifics of these choices are defined in the section for each channel type.
3. The Trigger Options (Fig. 3.2) define the trigger methods. These options include the trigger Source and Mode.
a) The Source trigger option allows the choice of a Manual Trigger (activated by a user) or an Input trigger,
coming from an input on a Digital I/O channel.
b) The Mode defines how the trigger activates a sequence. This includes input sequences, which can be triggered/gated by an outside source.
• In Triggered mode, the sequence is started manually or by a trigger source from another digital input
channel. Once the trigger source is received, the sequence will continue until the end or until Stop is
pressed.
• In Gated mode, the sequence will play as long as there is a high TTL signal (4 V or more) on the input
modulation BNC. This signal comes from a different light source or device driver. When the TTL signal is
Chapter 3. Doric Neuroscience Studio
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low (0.4 V or less), the sequence stops and waits for another high TTL signal to continue. This mode will
cut pulses, with a new pulse restarting once the high signal returns.
4. The Sequence Options (Fig. 3.2) define the parameters of each pulse sequence for output channels. These parameters are defined with each channel type. Should a parameter chosen be impossible to apply to a sequence (For
example, a Time ON greater than 1/Frequency), the color of the option boxes will turn RED.
5. The Sequence Preview (Fig. 3.2) section allows visualization of the output sequence that will play by selecting the
channel in the graph.
6. The Apply button (Fig. 3.2) will generate the defined channel OR update an already configured channel with any
changes.
Digital I/O Channels
With the Digital I/O channels, each digital channel can be configured as an output or an input and create TTL (On/Off)
pulse sequences. Each numbered channel corresponds to the same number digital channel on the console. Pulse sequences have different parameters depending on the Channel Mode, which can be Continuous or Square for output
sequences and Input for input signals. The Channels Configuration window contains the following elements for a Digital I/O channel.

Figure 3.3: Channel(s) configuration window, Digital I/O CW
• The CW(Continuous Wave) channel mode (Fig. 3.3) allows the creation of a continuous TTL pulse sequence. The
following elements appear in the Sequence Options box.
1. The Starting Delay defines the time between the activation of the pulse sequence and the beginning of the
signal.
2. The Time ON defines the length of time the continuous signal is active. Should the time chosen be 0, the
signal will continue until the pulse sequence is stopped manually.
3. The Total Duration shows the total expected duration of the pulse sequence. Should the duration be infinite,
the box will display ∞. If there is an error in parameter selection, this box will display N/A.
Chapter 3. Doric Neuroscience Studio
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• The Square channel mode (Fig. 3.4) allows the creation of a square TTL pulse sequence. This includes all sequence
options as the CW mode, with the following additions.
1. The Frequency sets the frequency (in Hz), which is the number of pulses per second. The frequency can also
be changed to the Period. For example, a signal at 10 Hz (frequency) will output one pulse every 100 ms
(period), whereas a signal at 0.5 Hz (frequency) will output one pulse every 2 seconds (period).
2. The Time ON defines the length of a single pulse. This time can also be converted to a Duty Cycle, which
indicates the % of the period the pulse duration corresponds to.
3. The Pulse(s) per sequence set the number of pulses per sequence. If it is set to 0, the number of pulses will
be infinite.
4. The Number of sequence(s) sets the number of times that the sequence will be repeated.
5. The Delay between sequences sets the delay between each sequence.
• The Input mode (Fig 3.2) receives a signal that is translated to 0 (Off) or 1 (On). The channel can then be used
as a trigger source for all the other channels of the console. No Sequence Options or Sequence Previews are
available for this mode.

Figure 3.4: Channel(s) configuration window, Digital I/O square

Chapter 3. Doric Neuroscience Studio
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Analog Output

Figure 3.5: Channel(s) configuration window, Analog Output CW
The Analog Output channel type creates analog pulse sequences. Each numbered channel corresponds to the same
number analog channel on the console. Pulse sequences have different parameters depending on the channel Mode,
which can be Continuous, Square or Sine. The Channels Configuration window contains the following elements for an
analog channel.
• The CW (Continuous wave) channel mode (Fig. 3.5) allows the creation of a continuous analog signal. The following elements appear in the Sequence Options box.
1. The Starting Delay (Fig. 3.5) defines the time between the activation of the pulse sequence and the beginning
of the signal.
2. The Time ON (Fig. 3.5) defines the length of time the continuous signal is active. Should the time chosen be
0, the signal will continue until the pulse sequence is stopped manually.
3. The Voltage (Fig. 3.5) defines the voltage of the continuous signal, in volts. The signal cannot go beyond
±4.75 V.
4. The Total Duration (Fig. 3.5) shows the total expected duration of the pulse sequence. Should the duration
be infinite, the box will display ∞. If there is an error in parameter selection, this box will display N/A.

Chapter 3. Doric Neuroscience Studio
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Figure 3.6: Channel(s) configuration window, Analog Output Square
• The Square channel mode (Fig. 3.6) creates a sequence of pulses with the minimum of the pulses at V- and the
maximum of each pulse at V+. This includes all sequence options as the CW mode, with the following additions.
1. The Frequency (Fig. 3.6) sets the frequency (in Hz), which is the number of pulses per second. The frequency
can also be changed to the Period. For example, a signal at 10 Hz (frequency) will output one pulse every 100
ms (period), whereas a signal at 0.5 Hz (frequency) will output one pulse every 2 seconds (period).
2. The Time ON (Fig. 3.6) defines the length of a single pulse. This time can also be converted to a Duty Cycle,
which indicates the % of the period the pulse duration corresponds to.
3. The Maximum Voltage (V+) (Fig. 3.6) defines the maximum voltage of each pulse, in volts. The signal cannot
go beyond +4.75 V.
4. The Minimum Voltage (V-) (Fig. 3.6) defines the minimum voltage of each pulse, in volts. The signal cannot
go beyond -4.75 V.
5. The Pulse(s) per sequence (Fig. 3.6) set the number of pulses per sequence. If it is set to 0, the number of
pulses will be infinite.
6. The Number of sequence(s)(Fig. 3.6) sets the number of times that the sequence will be repeated.
7. The Delay between sequences (Fig. 3.6) sets the delay between each sequence.

Chapter 3. Doric Neuroscience Studio
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Figure 3.7: Channel(s) configuration window, Analog Output Sine
• The Sine mode (Fig. 3.7) creates a sinusoidal pulse sequence with peaks at V+ and V-. This includes all sequence
options as the CW and Square mode, save the following.
– The Time ON option is changed for the Phase option (Fig. 3.7). This allows the choice of the sine wave phase,
in degrees.

Chapter 3. Doric Neuroscience Studio
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Analog Input
The Analog Input channels (Fig. 3.8) acquire from the Analog Input BNC connector ports. For these channels, Sequence Options are replaced by Global Options concerning the acquisition of data. These Global Options are applied
to all Analog input channels. They use different Channel Modes unique to the Analog Input channels.

Figure 3.8: Channel(s) configuration window, Analog Input Linear
There are two Global Options available to all Analog-in Modes.
1. The Acquisition Rate (Fig. 3.8) is measured in kilosamples per second. A rate of 1 kSps will acquire 1,000 samples
per second per channel. During an acquisition, a maximal amount of 3.6 * rate [in kSps] MB/min of data are created.
2. The Trigger Options defines the trigger source and mode.
a) The Trigger Source is eitherManual or a Digital I/O channels.
b) The Trigger Mode is either Triggered or Gated. Gated mode is only available when the trigger source isn’t
Manual.
Each Analog-In Mode has a specific set of paramters. The function of each Mode is described here.
• The Linear channel mode (Fig. 3.8) allows the direct measurement of signal received by a channel. The linear mode
has the option of a frequency filter, found in the Filter Options box.
1. When the Activate Filter checkbox is selected, the defined filter is applied on all input data and displayed on
a new trace. The filtered data is for display only, and will not be saved.
2. The Filter Family drop-down list is used to choose the filter type. These include Bessel, Butterworth and
Chebyshev (I ad I) filters.
3. The Filter Type drop-down list allows the choice of a filter type from High-Pass, Low-Pass, Band-Pass and
Band-Stop.
4. The Ripples box is only available for Chebyshev filters. The ripple (either in the passband, or in the stopband)
defines the acceptable filter response ripples. The higher the ripples, the sharper the filter response.
5. The Order selector is linked to filter sharpness; a higher order will provide a sharper filter.
6. The Cutoff Frequency boxes are used to define the low/high cutoff values for the filter, depending on the
type used. The cutoff frequency must be less than half of the sampling rate.
Chapter 3. Doric Neuroscience Studio
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(a) Filter Tab

(b) Response Tab

Figure 3.9: Linear Mode Filter Options
7. The Response Tab displays the filter response (attenuation) according to frequency.

Figure 3.10: Interleaved Acquisition Timing Diagram
• The Interleaved channel mode allows 2 channels to send an alternating pulsed signal of opposite phase for two
separate light sources. Each source can excite a different fluorophore, which allows the detection of two separate
fluorescence signals coming from the same sample using a single channel (Fig. 3.10). A more detailed procedure
to use this modality is included in section 3.1.3.

Chapter 3. Doric Neuroscience Studio
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Figure 3.11: Lock-in Acquisition Timing Diagram
• When using the Lock-In mode, the input will only record signals at a given reference frequency, filtered by a lowpass filter. This allows the detection of multiple different signals if each is at its own reference frequency (Fig. 3.11).
A more detailed procedure to use this modality is included in section 3.1.3.

Chapter 3. Doric Neuroscience Studio
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3.1.2

Control and Settings tabs

The three Control and settings tabs are used to manage the different parts of the software. There are three tabs,
Acquisition, Configuration and View.
Acquisition Tab
The Acquisition tab allows the activation of pulse and recording sequences. Three Live, Record and Time Series buttons are used for activation and will not function if no channels are configured. This includes the saving of data accumulated by these pulse sequences.

Figure 3.12: Acquisition Tab
1. The Live button (Fig. 3.12) activates all prepared channels. This mode does not automatically save data, keeping
only the most recent 700 000 data points in memory. This mode is not recommended for long or critical measurement sequences.
2. The Record button (Fig. 3.12) activates all prepared channels while periodically saving recorded data to the disk.
This mode is recommended for long measurement sequences.

Figure 3.13: Time Series Acquisition Timing Diagram
3. The Time Series button (Fig. 3.12) opens the Time Series Window (Fig 3.14). This window allows the organisation
of timed activation using the following parameters. Each Time series sequence is automatically saved to the same
.csv file as defined in Saving Options.
• The Settings box contains the series settings.
– The Number of series defines the amount of times the series is repeated.
– The Time ON defines the duration of the series.
– The Interval Between Series defines the amount of time between each series, if the Number of series
is greater than 1.
– The Total Duration displays the total duration of all series.
• The Progression box includes the Progression bar, which indicates the progression of the series (in %), while
the Time Elapsed counter indicates the progression of the series.
Chapter 3. Doric Neuroscience Studio

18

Figure 3.14: Time Series Window
• The Launch button start the series. While the series is active, it is impossible to add channels or change the
configuration, though View settings can be modified.
4. The Export Data button (Fig. 3.12) will export all data in the Acquisition view into a .csv file. This is the only way
to export data obtained will using the Live acquisition mode.
5. The Saving Options (Fig. 3.12) button opens the Saving Menu window (Fig. 3.15).

Figure 3.15: Saving Menu Window
• The Save file settings box is used to define how and where the file is saved. The name is taken from the
Filename box, while the save location can be chosen by clicking the ... button. The File Index box is used to
define the current indexation number used for multiple files saved during the same measurement session. All
this information is summarized in the Target File box.
• The Decimation Settings allow the reduction of file sizes. This method conserves points averaged over a
number of data points equal to the Decimation Factor1 . When the Enable decimation checkbox is selected,
the Decimation factor box is used to define the number of points averaged.
6. The Target File box (Fig. 3.12) displays the save location and name used for files obtained using Record.
Configuration Tab
The Configuration tab is used to configure which channels are used, as well as saving and loading the configuration of
the console software.
1 For

a data set of 10 points, saved with a Decimation Factor of 2, the first two points (1,2) will be averaged, the second two points (3,4)... This
produces a file of 5 points of data

Chapter 3. Doric Neuroscience Studio
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Figure 3.16: Configuration Tab
1. The Add Channel button (Fig. 3.16) opens the Channels configuration window. This window is detailed in section
3.1.1.
2. The Clear configuration button (Fig. 3.16) resets the acquisition view and all other parameters set. Any configurations already set will be lost.
3. The Save configuration button (Fig. 3.16) allows a console configuration to be saved in the .doric format. This file
will only preserve the configuration of each current channel.
4. The Load configuration button (Fig. 3.16) allows a console configuration in .doric format to be loaded.
View Tab
The View Tab (Fig. 3.17) is used to modify the presentation of graphs in the Acquisition view.

Figure 3.17: View Tab
1. The Autoscrolling button (Fig. 3.17), when clicked, makes the graphs scroll as new data appears. The duration
(in seconds) kept on display is defined in the box beside the button.
2. The Reset Zoom button (Fig. 3.17) sets the graph zoom to a pre-defined value. This value is defined using the
Zooming menu (Fig. 3.18), accessed using the Gear button.

Figure 3.18: Zooming Menu Window
Chapter 3. Doric Neuroscience Studio
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• The Time axis box is used to define the minimum and maximum values of the horizontal axis. If the Use OPTIMAL zooming range checkbox is selected, these values will be set to display all data currently in memory.
• The Y-Axis box is used to define the minimum and maximum value of the vertical axis. If the Synced zoom
on all Y-Axis checkbox is selected, these values can be changed. This only allows the Voltage axes to be
changed, to the same value for all. The Use OPTIMAL zooming range will set the axes to a value displaying
all data points in memory.
• The Modify button will apply any changes to the axis values. The Cancel button cancels all changes.
3. The Show Legend button (Fig. 3.17) will open the Legend window (Fig. 3.19). This window display each configured
Channel, as well as its Name, its Channel Mode, Trigger Mode and Trigger Source if applicable. Selecting the
button while a window is open will close the window.

Figure 3.19: Legend Window
4. The Show Notes button (Fig. 3.17) will open the Note Viewer window (Fig. 3.20). Selecting the button while a
window is open will close the window.

Figure 3.20: Note Viewer Window
• The Note(s) List displays the Title, Time and Graph on which a note is marked. Selecting the Delete button
will delete any note selected on the list.
• The Note Information box displays the information of a note selected in the Note(s) List. The Title, Time
and Note Text can be edited. The Apply button applies these changes to the graph.

3.1.3

Acquisition View

TheAcquisition View box displays all information concerning active channels. Each channel chosen using Add Channel
is displayed in this window, occupying a rectangular box.
Each Channel box shows the following basic elements, with additional elements available for specific channel types.
Chapter 3. Doric Neuroscience Studio
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Figure 3.21: Acquisition View Box
1. The Channel name is located on the upper left of the Channel box (Fig. 3.21), identifying the type of channel and
it’s number, corresponding to that on the console. This name can be modified in the Graph options window.
2. The Edit button (Fig. 3.21) allows the editing of channel parameters, opening the channel configuration windows.
For further information, see section 3.1.1.

Figure 3.22: Graphs Window
3. The Graph(s) (Fig. 3.21) button opens the Graph Options window.
Chapter 3. Doric Neuroscience Studio
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• The Channel Name (Fig. 3.22) is indicated in the upper left.
• The Trace # X box (Fig. 3.22) (where X is the number of the trace) show the visual options available for a
single trace on the graph. A trace box appears for each trace on the graph.
– The Trace Name box contains a standard name generated by the software. The name can be changed
here.
– The Trace Color button (...) opens the Color Select window (Fig. 3.23), which allows the selection of a
trace color from a wide palette. The Pick screen color in this window allows the selection of any color
displayed on the computer screen.

Figure 3.23: Select Color Window
– The Trace style drop-down list allows the selection of the type of trace, from full to dashed lines. If the
style chosen is empty, the trace will not be displayed.
– The Trace size drop-down list allows the selection of the trace size. Using a bigger Trace size than the
default may result in slower display nd performance degradation.
– The Type of points drop-down list allows the selection of what type of point used to indicate data points
on the trace. Using different point types than the default (none) may result in slower display and performance degradation.
4. The Graph (Fig. 3.21) box displays the graph of a channel, with Voltage or State as the vertical axis and Time as
the horizontal axis. Double-clicking either axis will open a Change Axis Range window that allows the axis limits
to be changed, as in the Zooming Menu. Any changes done on a horizontal axis will change the axis limits for each
channel.
5. The Instant values box (Fig. 3.21) can be activated by right-clicking the Input graph box and selecting Show instant values. This box shows the current value detected by the console for each trace on the selected channel.
This box cannot be activated on Preview graphs.
6. The Channel tabs (Fig. 3.21) appear in certain input modes (such as Interleaved and Lock-in) where the input
automatically sets the output values on separate channels. It is possible to create a Channel tab by undocking one
channel and moving it above another until it turns blue, then releasing it.
7. Analog output channels display an Active state graph (Fig. 3.21). This graph displays whether the channel is outputting a signal (On, V6=0) or not (Off, V=0).
8. Output channels display a Preview graph (Fig. 3.21), showing a preview of the pulse sequence.
Chapter 3. Doric Neuroscience Studio
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The following section describes the usage of the Interleaved measurement mode for Analog Input channels. Once
the Interleaved channel mode is chosen, the the Interleaved/Sequential options box (Fig. 3.24) appears, containing
the following parameters.
1. The Channel # drop-down lists allows the choice of interleaved outputs. Once Channel #1 has been selected,
Channel #2 only allows the same type of output (analog or digital) to be selected.
2. The Preconfiguration drop-down list allows the choice of a pre-configured frequency for the interleaved channels.
The previously selected channels are configured to function at the chosen frequency.

Figure 3.24: Channels configuration, Analog Input Interleaved Mode
The following steps describe the basic manner in which to use Interleaved Mode.
1. Select two channels from the Channels # lists.
2. Select a frequency from the Preconfiguration list.
3. Connect the Fiber Photometry Console to at least two different light sources using the outputs preconfigured for
interleaved mode in the previous step. Ensure the driver(s) are in TTL mode (for digital channels) or MOD mode
(for analog channels), with the driver set at the desired maximum current level (in mA).
4. Connect the detector to the appropriate analog input channel(s) corresponding to the input.
5. Start measurement using Play or Record on the Acquisition tab.
6. After a measurement is made, 3 traces are available in the Graphics/Traces List.
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Figure 3.25: Acquisition View, Interleaved Mode Traces
• The Raw Data (AIn-1) (Fig. 3.24) shows the raw signal received on the input channel.
• The Intermediate Data (AIn-1 x DI/O-1) (Fig. 3.24) traces show the fluorescence signal caused by each light
source, obtained by multiplying the output signals by the input signal.
• The Deinterleaved Data (AIn-1 x DI/O-1(mean)) (Fig. 3.24) shows the averaged signal of each demodulated
pulse. This leaves a single averaged point per pulse sent by the output channels.
The following section describes the usage of the Lock-in mode for Analog Input channels. Once the Lock-in channel
mode is chosen, the Lock-in options box (Fig. 3.26) appears, containing the following parameters.

Figure 3.26: Channels configuration, Analog Input Lock-in Mode, Carrier Tab
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1. The Channel List (Fig. 3.26) indicates which channels are used to output a reference frequency. Multiple output
channels can be selected for a single input channel. Any output channels already configured by a different input
channel will be usable, but not configurable. The output configuration must be changed in the initial input channel.
2. The Enabled checkboxes are used to select which output channels are in use.
3. The Reference frequency (Fig. 3.26) allows the choice of a reference frequency. The reference frequency should
not be a multiple a of known noise frequency (e.g. 60 Hz), or a multiple of another reference frequency.
4. The Vmax/Vmin (Fig. 3.26) defines the voltage sent from the console to the device. The minimum possible difference is of 0.1 V for the LEDD. The Vmin value is 0.1 V for the LEDD and 0.2 V for the LEDRV.
5. The Cutoff Frequency (Fig. 3.27) (the frequency at which a -3 dB attenuation will occur), found on the Filter tab
is kept fixed at 12 Hz for optimal filtering results.
6. The Filter response is displayed on the Filter tab.

Figure 3.27: Channels configuration, Analog Input Lock-in Mode, Filter Tab

Chapter 3. Doric Neuroscience Studio

26

3.2

Photometry Analyser

This module provides an easy means to extract relevant data from the data acquired by the Doric Fiber Photometry
Console. The software loads data in .CSV or .doric format, implements signal processing functions and saves the traces
in .CSV or .doric format. This software does not replace standard analysis tools such as Matlab, ImageJ or Excel, but aims
to offer useful processing algorithms developed for the photometry data.

Figure 3.28: Photometry Analysis Module Interface
1. The Graph Box displays the loaded data, allows navigation through the points by zooming and dragging.
2. The Function Toolbar contains all the buttons and the functions accessible.

3.2.1

Function Toolbar

1. The File Tab (Fig. 3.29) is used to load/save data,

Figure 3.29: File tab
• The Load Data button loads a .CSV or .doric file with the first row being the headers, and the first column
being the x-axis. The imported column(s) can be chosen.
• The Save Data button saves the user-defined data to a .CSV or .doric file.
• The Clear all button clears all loaded data from the module. This clearing cannot be undone.
2. The View tab (Fig. 3.30) is used to manipulate the appearance of the displayed data.
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Figure 3.30: View Tab
• The Set Zoom button opens the Set custom display range window (Fig. 3.31). This window allows the selection of the axis values associated with the Reset Zoom button. The Automatic option will choose values to
display all loaded data.

Figure 3.31: Set Custom Display Range Window
• The Reset Zoom button rescales the axes to values set in the Set Zoom function.
• The Toggle graphs button opens the Show/Hide Graph(s) window (Fig. 3.32). The list in the window is used
to toggle current graphs on or off.

Figure 3.32: Show/Hide Graph(s) Window
• The Toggle cursor button adds a cursor to the graphs that shows local coordinates of time and intensity, as
displayed in red on figure 3.28.
3. The Processing tab is used to control the various processing functions.
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Figure 3.33: Processing Tab
• The Arithmetics function applies basic arithmetic operations (+, −, ×, ÷) between 2 channels. The result is
shown in a new graph.

Figure 3.34: Arithmetics Window
• The Filter function opens the Filter (Fig. 3.35) window uses a butterworth filter to remove unwanted frequencies from the data. These filters can be Bandpass, Bandstop, Low-pass or High-pass.

Figure 3.35: Filters Window
• The ∆F/F0 function opens the Select Which Traces to Process window (Fig. 3.36). It is used to calculate the
normalized fluorescence variation of the data and displays the results in a new graph. See section 3.2.2 for
more details.
– Reference channel is chosen using the channel list. The ∆F/F0 can either be calculate for a channel with
itself, or with another channel as the reference (e.g. if one channel represents the signal, and the other
channel represents the reference). In the latter, the ∆F/F0 is calculated independently for each channel,
and the signal and the reference are subtracted.
– F0 calculation method shows the method used to evaluate F0 , either using a running average or the
least mean squares method.
– The Time Range (s) allows a segment of time to be chosen for processing from the loaded dataset.
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Figure 3.36: ∆F/F0 Options

3.2.2

Algorithms

∆F/F0
For each point, the processed fluorescence intensity It is defined as It = (Ft − F0 )/F0 , where Ft represent the fluorescence intensity at time t. For the running average F0 calculation option, the algorithm is inspired from G. Cui, S. B. Jun,
G. Luo, M. D. Pham, S. S. Vogel, R. M. Costa, Deep brain optical measurements of cell type-specific neural activity in behaving mice, Nature Protocols 9, 1213-1228 (2014). Briefly, F0 is calculated as the running average fluorescence intensity
variation over a window of 1 minute. If less than 1 minute is available, the algorithm will use the average of all the data.
If the calculation method is least mean square, the algorithm is inspired from T. N. Lerner, C. Shilyansky, T. J. Davidson,
L. Luo, R. Tomer, K. Deisseroth Intact-Brain Analyses Reveal Distinct Information Carried by SNc Dopamine Subcircuits, Cell
162, 635-647 (2015). The algorithm will calculate the least mean square fit of the whole data series, and use that fit as
the F0 .
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4
Specifications

Table 4.1: General Specifications
SPECIFICATION

VALUE

NOTE

Power supply
DC power supply
Mass
Dimensions

110 - 240 VAC ; 50 - 60 Hz Power supply adapter included
12 VDC
797 g
36 cm x 3.63 cm x 9.82 cm Depth includes connectors

Digital input voltage
Digital output voltage
Digital input impedance
Digital output impedance
Digital time propagation delay
Digital time input resolution
Digital time output resolution

0 to +5 V
0 to +5 V
3 kΩ
30 Ω
4.6 ns
82 µs
10 µs

Analog output voltage
Analog output sample frequency
Analog output max. frequency
Analog output impedance
Analog time propagation delay

± 4.75 V
25 MS/s
10 khz
6Ω
20 ns

Analog input voltage
Analog input sample frequency
Channel-to-channel isolation
Analog input impedance

±10 V
15 kS/s
110 dB
100 to 124 kΩ

Min Hi Level: 4 V; Max Low Level: 0.55 V

Chopping Enabled: This mode provides very low noise with lower output rates. Chopping does not eliminate the offset
error and drifts caused by input resistors. Noise performance depends on the selected analog input range and the chopping mode. The analog input is always operated with chopping mode in order to optimise the offset drift and to allow a
better noise performance. When starting an acquisition, input data rate (Samples per second) can be selected according
to the needs of each test. Higher data rate provides higher RMS noise. Analog inputs are reversed and then calculated
as an average of two conversions in order to reduce the offset error.
1
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Table 4.2: Analog input noise and resolution specifications with chopping mode enabled
Data rate

Real Rate

Time
resolution

- 3dB
Frequency

0.3 kSps *C
1.0 kSps *C
2.5 kSps *C
6.0 kSps *C
12. kSps *C

372 Hz
1 001 Hz
2 534 Hz
6 041 Hz
12 166 Hz

2686 µs
999 µs
395 µs
166 µs
82 µs

200 Hz
520 Hz
1 300 Hz
3 100 Hz
6 300 Hz

RMS
noise

Effective resolution1

9.6 µV
15.5 µV
26.1 µV
46.0 µV
120 µV

20.0 bits (9.5 µV/bit )
19.3 bits (15.5 µV/bit )
18.5 bits (27.0 µV/bit )
17.7 bits (47.0 µV/bit )
16.3 bits (123.9 µV/bit )

1
Effective resolution for linear mode at ± 10 V input range. Input resolution is 16 bits (0.152 mV). Lower data rates provides higher effective resolution. The lock-in mode allows higher effective resolution. In this case, effective resolution is
higher than RMS noise for every listed frequency.

Table 4.3: Recommended Environmental Specifications
DESCRIPTION

OPERATION

STORAGE

Use
Temperature
Humidity

Indoor
0-40 ◦ C
40-60% RH, non condensing

Indoor
0-40 ◦ C
40-60% RH, non condensing

Figure 4.1: Electronic Bloc diagram
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5
Support
5.1

Important handling information

Warning: Do not open the box to avoid electrical injury.

5.2

Maintenance

The product does not require any maintenance. Do not open the enclosure. Contact Doric Lenses for return
instructions if the unit does not work properly and needs to be repaired.

5.3

Warranty

This product is under warranty for a period of 12 months. Contact Doric Lenses for return instructions. This warranty
will not be applicable if the unit is damaged or needs to be repaired as a result of improper use or operation outside the
conditions stated in this manual. For more information, see our Website.

5.4

Contact us

For any questions or comments, do not hesitate to contact us by:
Phone 1-418-877-5600
Email sales@doriclenses.com

© 2019 DORIC LENSES INC
357 rue Franquet - Quebec, (Quebec)
G1P 4N7, Canada
Phone: 1-418-877-5600 - Fax: 1-418-877-1008
www.doriclenses.com
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